
Introducing Microsoft Media Player

Microsoft Media Player is a universal media player you can use to receive content in most popular media formats. The player 
can be used to receive streaming media from the Internet or an intranet, or to open stored multimedia files.

Click an area of the image below (or press TAB to highlight it, and then press ENTER) to learn more about Media Player controls
and components.



Media formats supported by Media Player

The file name extensions for the media types supported by Media Player are associated with Media Player (Mplayer2.exe) when 
you install it. This means that when you open a file that has one of these extensions, either by double-clicking a file icon or a link 
in a Web page, Media Player starts.

The media formats supported by Media Player include:

Microsoft NetShow formats
File name extensions: .asf, .asx

RealNetworks™ RealAudio® and RealVideo® (version 4.0 or lower)
File name extensions: .ra, .ram, .rm, .rmm

Audio Visual Interleave
File name extension: .avi

Moving Pictures Experts Group (MPEG)
File name extensions: .mpg, .mpeg, .m1v, .mp2, .mpa, .mpe

Musical Instrument Digital Interface (MIDI)
File name extensions: .mid, .rmi

Apple® QuickTime®, Macintosh® AIFF Resource
File name extensions: .qt, .aif, .aifc, .aiff, .mov

Sun™ Microsystems and NeXT™ (Java)
File name extensions: .au, .snd

Audio for Windows
File name extension: .wav



To Connect to a NetShow Theater server and Play a title

To play a Microsoft NetShow Theater title, you must first connect to a NetShow Theater server. Your computer must be on the 
same dedicated network as that server.

To connect, you must know the name of the NetShow Theater server and the file name of the title (as named on the title server) 
that you want to play.

1 On the File menu, click Open.

2 Type nsm://titleservername/title

3 Click Open. 

For example: if the title server name is Madrid and the title is Vous.mpg, you would type:
nsm://Madrid/Vous.mpg

The titles available on the NetShow Theater title server are listed in the Titles view of the NetShow Theater Administrator. You 
can add MPEG format files, or the example titles from the NetShow Theater compact disc from the administrative workstation. 
For more information about managing content, See the Microsoft NetShow Theater Server Administration Guide.

Related Topics

NetShow Theater troubleshooting



To play streamed content

You can use Media Player to receive streaming content from the Internet or an intranet in Microsoft Advanced Streaming Format 
(ASF), or RealAudio® and RealVideo® formats (version 4.0 or lower). To receive and play a stream, you must know the address 
(URL) for the content. Streaming content may also be accessed by opening NetShow Advanced Streaming redirector (ASX 
or .asx) or RealAudio® Metafile (.ram) files. 

1 On the File menu, click Open.

2 Type the URL to the content or metafile.

An example URL to a NetShow server:
mms://servername/publishingpoint/title.asf

An example URL to an .asx file on a Web server:
http://webserver/virtualdirectory/filename.asx

Note You can also open a metafile by clicking a hyperlink to it in a Web page.



To play a stored multimedia file

Microsoft Media Player is a universal media player which can play multimedia files in most popular formats. When Media Player 
is installed, the file-name extensions (the three characters after the period in the file name, such as .avi) for the supported media 
formats are taken over. This means that Media Player becomes the application associated with a these file types. When you 
open a file that has one of these extensions through Windows Explorer, or a link in a Web page, the file opens and plays in 
Media Player.

See Media Formats Supported by Media Player for a list of supported formats and file-name extensions.

1 On the File menu, click Open.

2 Type the full path to the file you want to play. To search for the file you want, click Browse.



Media Player File Properties dialog box

The Media Player File Properties dialog box is the main source of information about the media content currently playing. The 
tabs displayed in the Properties dialog box vary depending on the type of content. For example, the Show tab appears only if the
content was opened using an Advanced Streaming redirector (.asx or ASX) file or RealAudio® Metafiles (.ram). The Clip tab 
always appears, but contains information only if the content playing was opened using a    metafile. 

Related Topics

Show tab

Station tab

Clip tab

Details tab

Advanced tab



Clip tab

The Clip tab in the Properties dialog box contains information about the clip currently playing. A clip is a piece of streaming 
content or a media file. Information displayed on the Clip tab is read by the player from the metafile that was opened to start the 
stream.

Information shown on the Clip tab includes:

Title
The title of the clip currently playing (or any text supplied by the content author)

Author
The author of the clip currently playing

Copyright
Copyright information about the clip currently playing

Rating
The rating of the clip currently playing

Location
The path to the clip currently playing

Related Topics

Show tab

Station tab

Details tab

Advanced tab



Station tab

The Station tab in the Properties dialog box displays information about the station currently playing. The Station tab is displayed
only if the media currently playing is a NetShow Station accessed by opening a NetShow Station (.nsc) file. NetShow Station 
files can only be opened by opening an announcement file, also called an ASX    metafile, generated by NetShow administration 
tools, that contains a link to a stored .nsc file.

The information on the Show tab is defined during the creation of the station file on a NetShow server. If no information is 
displayed, there was none provided by the station administrator.

Information shown on the Show tab includes:

Name
The name of the station you are currently viewing. Stations are named when they are created by the content creator or 
NetShow administrator.

Contact Address
The Contact Address, if any, is provided by the content creator. This Contact fields are intended to be used to allow the content 
creator to provide information to the viewer or listener of the station. The information displayed here can be anything defined by
the author or owner of the station.

Contact Phone
The data in the Contact Phone field is provided by the content creator. This data is intended to be used for providing the 
viewer with a phone number to contact the content creator. The content creator can fill this field with any text.

Contact Email
This field is also defined by the content creator. The data contained in this field can be any text the creator of the station wants. 
This field is intended to allow the station creator to provide the viewers of the station an e-mail address to send mail to 
regarding the station. 

Location
The Location field displays the URL of the announcement (.asx) file opened to view this station. Usually, this will be the URL of
the Web server virtual directory where the file is stored. This is not the URL of the station itself. NetShow stations can only be 
accessed by opening an .asx file that defines a URL to an .nsc file. 

Description
The Description box contains text entered as a description of the station when the station file was created. This descriptive 
text is provided by the content creator and may contain any information. If the length of the text is longer than fits in the box, the
scroll bar becomes active.

Related Topics

Show tab

Clip tab

Details tab

Advanced tab



Show tab

The Show tab in the Properties dialog box displays information received by the player from an ASX file. The Show tab appears 
in the Properties dialog box only if the content currently playing was opened using an ASX file.

Information shown on the Show tab includes:

Title
The title of the show currently playing, which could include several clips. The title of the show is defined in the ASX file used to 
open the show.

Author
The author of the ASX file that was opened to start the show.

Copyright
Copyright information about the show currently playing.

Rating
The rating of the show currently playing. Rating information is delivered to the player with the stream.

Location
The URL of the metafile that was opened to play the show content.

Related Topics

Station tab

Clip tab

Details tab

Advanced tab



Details tab

The Details tab in the Properties dialog box displays information about the physical details of the file currently playing. The 
information is updated dynamically. 

Information shown on the Details tab includes:

Type
The type of file currently open, such as Advanced Streaming Format (ASF) or video clip (AVI).

Size
The size of the clip currently open.

For live streams, Size is set to Not known. If the clip was opened using a metafile, Size reflects the file size of the ASX file.

Media Length
The length, in time, of the title currently playing. For live streams, the Media Length is set to Live.

Video Size
The height and width, in pixels, of the video content of a title. For audio-only files, Video Size is set to No Video.

Created
The date the clip was created. If the clip was opened with an ASX file, Created reflects the creation date of the ASX. 

If the title currently playing was opened via an ASX file, information on the Details tab reflects the values for the ASX file, not the 
content stream.

Related Topics

Show tab

Station tab

Clip tab

Advanced tab



Advanced tab

The Advanced tab in the Properties dialog box displays information about the filters in use for the content currently playing. To 
get more information about each filter displayed in the Filters In Use box, select the filter you want, and then click Properties.

Related Topics

Show tab

Station tab

Clip tab

Details tab



Media Player Options dialog box

The Options dialog box is where you can select the options for how Media Player plays content, such as audio balance, video 
zoom, and whether to play each title in the same player window or to open a new player for each title. The settings you select 
become the default for the player. The player opens with these settings each time you start it.

To open the Options dialog box
On    the View menu, click Options.

Click Related Topics below to learn more about each of the Option dialog box tabs.

Related Topics

Playback tab

Player tab

Custom Views tab

Advanced tab



Custom Views tab

The Custom Views tab in the Options dialog box allows you to define which parts of Media Player will be visible when the player
is open. The default view for the player is the Standard setting, which displays all parts of Media Player. You can also change the
name of the view.

To change which parts of Media Player are displayed

1 On the View menu, click Options.

2 Click the Custom Views tab.

3 Select the check box next to each part of Media Player you want to display.

4 Clear the boxes next to the area you do not want to display. You can customize two different views.

5 When finished, click Apply, and then click OK.

On the Custom Views tab, you can change the name of the custom view, which also updates the name of the view on the View 
menu. Because the view settings can be customized, you can define the settings for a view based on a particular type of content.
The term “minimal” or “compact” may not appropriately define the view, so you can name the view something that makes sense 
to you, such as AVI Files or Radio for audio-only streams.

To change the name of the custom view on the View menu

1 Delete the name of a view in the Name on View menu box .

2 Type the name of the view as you want it to appear in the View menu. Notice that the text above the section for the view 
changes as you type.

3 If you want, you can type an ampersand ( & ) in front of the letter you want to be underlined in the View menu. The underlined 
letter represents the key you press to perform the command by using the keyboard.

You do not have to specify a letter to underline, but if you do, do not use one already in use for another command.

4 Click Apply to update the View menu with the new name.

Related Topics

Playback tab

Player tab

Advanced tab



Advanced tab

The Advanced tab in the Options dialog box displays information about buffering and protocols. 

Buffering
The buffer is the amount of Advanced Streaming Format (ASF) information, measured in seconds, that Media Player “saves 
up” ahead of what is playing. Media Player uses the information stored in the buffer to fill in gaps in the ASF stream caused by 
network traffic. You can use the default buffer, or if you know that you may experience heavy network traffic, you may want to 
set your own buffer. 

Protocols
The protocol settings are the various ways that Media Player can receive ASF information. Multicast, UDP, TCP, and HTTP 
protocols are enabled by default. Select the protocols that you want to enable. The protocols you select to use will be tried in 
succession following Protocol Rollover rules. If a title cannot be opened using one protocol, the other protocols selected here 
will be tried one after the other.

Protocols are tried in the following order, if selected: UDP, TCP, then HTTP.

Do not select UDP streaming unless you are on a local or high-bandwidth network that does not have large delays caused by 
network traffic.

Protocol Rollover
The ability of a player to try different protocols automatically to access a stream from a server. The rules for rolling over from 
one protocol to another are defined by a combination of the station definition, the announcement, and various preferences set 
by you on your computer.

Related Topics

Playback tab

Player tab

Custom Views tab



Playback tab

The Playback tab in the Options dialog box contains settings for audio controls, video zoom, and playback repeat.

You can change the following settings on the Playback tab:

Audio

Volume - The Volume slider controls the volume level of audio content. Changing the volume setting on the Playback 
tab is the same as using the Volume slider in the main player window.

Balance - The Balance slider sets the audio balance in the same manner as the balance control for a stereo. Sliding the
bar to the left causes the volume of the audio to be louder in the left speaker and weaker in the right speaker.

Video

Zoom - The Zoom setting defines the size of the video area in the player. The default setting is 100%, which is the 
original size of the video delivered to the player. When the Zoom setting is changed, the player window is resized to fit 
around the Video area. The size of the video itself is resized proportionally.

To change the Video Zoom setting

1 Click the Zoom drop-down bar.

2 Click the setting you want (50%, 100%, or 200%)

3 Click Apply, and then click OK.

Playback

The Playback options let you set how many times each piece of content you access plays, and whether to rewind a clip 
when it is done playing. You can either set a specific number of times for a title to play, or set it to repeat until you click 
Stop or close the player. If you open a title by using a metafile, the definitions of the metafile may override your 
Playback settings.

To set the number of times a clip will play

1 Click the button next to Play in the Playback area.

2 In the box next to the Play button, type the number of times you want each title to play.

3 To play a clip over and over, click the Repeat forever button.

4 Click Apply, and then click OK.

To automatically rewind a title when it is done playing

1 Select the Rewind when done playing check box.

2 Click Apply, and then click OK.

Related Topics

Player tab

Custom Views tab

Advanced tab



Player tab

In the Player tab in the Options dialog box you can set which Custom View will be used as the default when the player is started,
as well as whether to open each title played in the same player window, or to open a new player window each time you play a 
new title.

The Open Options setting applies only to opening a new media file from outside of the player. This means that if you open a 
media file from the File menu or a Favorites shortcut, the file always opens in the same player window.

If you click the Open a new player for each media file played button (or click ALT+N while the Options dialog box is open), 
each media file you open by clicking a link in a Web page, opening an .asx file, or typing a URL to an .asx or .asf file in the 
browser address bar or a command line is played in a new player window.

Note: Opening multiple player windows playing streaming media over a low-speed (28.8) internet connection may adversely 
affect the playback of the media as well as the performance of your computer.

Related Topics

Playback tab

Custom Views tab

Advanced tab



Go To dialog box

The Go To dialog box (choose Go To from the View menu) is available only if the content currently playing has markers defined 
in its index. Markers can only be defined in stored content, and are put in the stream by NetShow Content Creation tools.

The dialog contains Time and Description fields. The Time field displays the position in the time index for the media where the 
markers begin. The Description field displays the name of the marker defined, which begins at the corresponding time.



Media Player Statistics dialog box

The Statistics dialog box contains data about the content currently playing, such as the frame rate, and network information. You 
can use the information in the Statistics dialog box to help determine if the quality of the playback is being affected by network 
traffic.

Information contained in the Statistics dialog box includes:

Video

Frames skipped - The number of frames skipped in the playback of a video stream.

Frame rate - The frame rate at which the stream was encoded.

Actual rate - The frame rate achieved in the playback of the content.

Network

Protocol- The protocol in use to receive the content currently playing.

Error correction - The error correction method in use, if any. Error correction is enabled in the stream by the content 
creator.

Bandwidth- The bandwidth of the stream currently playing, in bits per second (bps).

Packets received - The number of packets received by the player since the opening of the stream or title.

Packets recovered - The number of packets recovered after being lost.

Packets lost - The number of packets lost from the stream received by the player.

Connection quality - The percentage of packets received over the last 30 seconds.



Media Player Troubleshooting topics

More information will follow in the post-beta release.



Media Player error messages

More information will follow in the post-beta release.



To add a clip or show to your Favorites list

You can add clips to a list of favorites in much the same you can add favorite Web sites to a list in a browser. Any entry you add 
to your favorites list is easily accessible from the Favorites menu.

To Add a Clip to Your Favorites

1 Open the clip you want to add.

2 While it is open, click the Favorites menu , and then click Add to Favorites.

3 Type in a new name for the entry if you want to change it.

4 Select the folder you want the entry added to, if other than the default, by clicking Create In.

5 Click the folder to which you want the entry added.

6 Click OK.



Organizing your Favorites

You can organize your list of favorites just like favorites or bookmarks in a browser. 

On the Favorites menu, click Organize Favorites .

More information will follow in the post-beta release.



Checking for a new version

More information will follow in the post-beta release.



Information about upgrading Media Player

More information will follow in the post-beta release.



File menu

The File menu contains the following commands or submenus:

Open

Close

Properties

More Information

Exit



Open command 

Use the Open command to open the Open dialog box.

Back to File menu



Close command

Use the Close command to close the media currently playing. The player keeps a file open until you close it or exit the player.

Back to File menu



Properties command

The Properties command opens the Properties dialog box.

Back to File menu



Properties dialog box

The Properties dialog box contains information about the media currently playing in the player.

See the Properties dialog section for more information.

Back to File menu



More Information submenu

More Information on the File menu is available only if the content you are viewing was opened using an ASX file. If the author 
of the ASX file included a special command in it, the More Information submenu will be available. It contains three commands 
that, when clicked, start your Web browser and go to the URL defined in the ASX file. The author of the ASX can also define an 
e-mail link or path to a file on your local area network.

Back to File menu



Exit command

The Exit command exits (or closes) Media Player.

Back to File menu



Open dialog box

The Open dialog box is used to open media files or streams. You can open media content two different ways in the Open dialog 
box:

Type the address or path to a media stream or saved file

Click Browse and explore your computer or network for saved media files

Related Topics

Playing streamed content

Playing stored multimedia files

Back to File menu



View menu

The View menu, contains the following commands and submenus:

Standard

Compact

Minimal

Full Screen

Zoom

Statistics

Captioning

Always On Top

Options. . .



Standard command      (CTRL+1)

Click Standard    to put the player in Standard view mode. In Standard mode, all parts of the player on displayed. You can also 
choose Minimal or Compact views, or define your own custom view in the Options dialog box.

Related Topics

Custom Views

Minimal command

Compact command

Return to View menu



Compact command      (CTRL+2)

Click Compact to put the player in Compact view mode. Compact is a default name for one of the two custom views you can 
define. You can customize Media Player to display the controls and components you want and hide the ones you don’t want. For 
more information, see Custom Views.

Note: Compact is the default name of a Custom View. If you change the name of the view in the Custom Views tab of the 
Options dialog box, the menu will display the name you selected instead of Compact.

Related Topics

Custom Views

Minimal command

Standard command

Return to View menu



Minimal command      (CTRL+3)

Click Minimal to put the player in Minimal view mode. The default settings for Minimal mode include the display of the video area
and the controls only.

Minimal is a default name for one of the two custom views you can define. You can customize Media Player to display the 
controls and components you want and hide the ones you don’t want. For more information, see Custom Views.

Note: Minimal is the default name of a Custom View. If you change the name of the view in the Options dialog box, the menu 
will display the name you selected instead of Minimal.

Related Topics

Custom Views

Compact command

Standard command

Return to View menu



Full Screen command      (ALT+ENTER)

Click Full Screen to display the video currently playing over the entire computer screen.

For more information, see Full Screen mode.

Return to View menu



Full Screen mode

When in Full Screen mode, video content is displayed in the entire monitor screen. No controls or other player components are 
displayed. To enter Full Screen mode, press ALT+ENTER or click the Full Screen command on the View menu.

Return to View menu



Zoom command

The Zoom command opens a submenu. The Zoom command    is available only when playing video content. The submenu 
contains three commands:

·  50 %

· 100 %

· 200 %

These commands change the current Zoom setting for the player. The default Zoom setting is 100%, which is the original size of
the video media playing. 

Return to View menu



Statistics command

The Statistics command opens the Statistics dialog box.

For more information, see Statistics dialog box. .

Return to View menu



Captioning command

The Captioning command turns on or off Closed Captioning. When captioning is turned on, the player window is expanded 
vertically, allowing space below the video area for the captioning text.

Return to View menu



Always on Top command

Click Always on Top to turn on or off the Always on Top mode of the player. When this is turned on, the player is always 
displayed in front of other open windows, even when they are active. There is a check mark next to the menu command when 
Always on Top is turned on.

Return to View menu



Options command

The Options command opens the Options dialog box.

Return to View menu



Play menu

The Play menu contains the following commands:

Play / Pause        

Stop

Skip Back

Skip Forward

Rewind

Fast Forward

Preview

Go To

Language

Volume



Play / Pause command    

Click Play / Pause to play a media file or stream if it is paused or stopped, or pause a media clip if it is playing. This menu 
command combines the functions of the Play and Pause buttons.

Return to Play menu



Stop command

Choosing Stop has the same function as clicking the Stop button. If a stream or media is playing, the Stop command stops the 
playback. If you choose Stop while a title is opening, title is not opened.

Return to Play menu



Skip Back command

Clicking this command has the same function as the Skip Back button; it restarts the playback of the clip currently playing from 
the beginning of the clip. If you choose Skip Back command during the first second of playback, the player skips back to the 
beginning of the previous clip in the playlist. The Skip Back command is available only if the media you are viewing was opened 
using a playlist. A playlist is created using an ASX file, and is a list of one or more pieces of content that play in order when the 
ASX file is opened.

Return to Play menu



Skip Forward command

Click Skip Forward to bypass the remainder of the current clip and begin the playback at the beginning of the next clip in a 
playlist. This command is unavailable unless the content currently playing is a clip defined as part of a playlist in an ASX 
metafile.

Return to Play menu



Rewind command

Click Rewind to rewind the content playing. This command is only available if the content playing is a stream from a NetShow 
server. The stream must be an on-demand, stored content stream containing an index for you to be able to rewind it.

The function of the Rewind command is a little different than the Rewind button on the player control bar. When Rewind is 
chosen from the menu, the player rewinds until you issue another command to the player, such as clicking another button or 
choosing another menu command.

Note: Rewind does not mean the same thing on the Internet as it does on a compact disc or tape player. The content 
streaming over the Internet is compressed using codecs, and has to be decompressed by Media Player on your computer. 
When you rewind a media stream, you may only see key frames of video content, and on slower connections see nothing at all.
When you stop rewinding, Media Player buffers the streams and begins playback again.

Return to Play menu



Fast Forward command

The Fast Forward command is available only for media content received from a NetShow server which contains an index. You 
cannot fast-forward or rewind real-time or live streams. Click Fast Forward command to quickly advance media playback. When
you choose the command from the Play menu, the player continues to fast-forward the content until you choose another 
command. You can stop fast-forwarding by clicking a button other than Fast Forward, choosing another command from the 
menu, or using an accelerator key.

Note: Fast Forward does not mean the same thing on the Internet as it does on a compact disc or tape player. The content 
streaming over the Internet is compressed using codecs, and has to be decompressed by Media Player on your computer. 
When you fast-forward a media stream, you may only see key frames of video content, and on slower connection see nothing 
at all. When you stop fast-forwarding, Media Player buffers the streams and begins playback again.

Return to Play menu



Preview command

Click Preview to put the player in Preview mode, which means that a section of each clip in a playlist is previewed. The default 
setting for the duration of a preview is 10 seconds. If you open content using an ASX file, the duration of the preview may be 
different if the author of the ASX file set a different value for it.

Return to Play menu



Go To command

The Go To command refers to markers. This command is available only if the content you are playing contains markers, which 
are named or numbered points in the content. Markers can be inserted into content streams only by using NetShow tools. Click 
Go To to open the Go To dialog box.

Return to Play menu



Language command

Text to come.

Return to Play menu



Volume command

Click Up to raise the volume of the content you are playing. Click Down to lower the volume. Click Mute to turn off the sound. A 
check mark next to Mute indicates that the sound is off. To turn the sound on again, click Mute again.

You can also adjust the volume by clicking or dragging the slider in the Play Bar. 

The Volume commands are unavailable if your computer does not have a sound card or sound driver installed.

Return to Play menu



Contents command

Clicking Contents opens the Help Contents.

Return to Help menu



Troubleshooting command

Clicking Troubleshooting opens the Troubleshooting section of the Help file.

Return to Help menu



Check for Player Upgrade

Text to come.

Return to Help menu



About Media Player command

Clicking    About Media Player displays the version and copyright information for Media Player.

Return to Help menu



Closed Captioning

Text to come.



Favorites menu

The Favorites menu contains commands for using favorites:

Add to Favorites

Organize Favorites



Help menu

The Help menu contains these commands:

Contents

Troubleshooting Guide

Check for Player Upgrade

About Media Player



Add to Favorites command

Click Add to Favorites to open the Add Favorite dialog box.

More text to come.

Return to Favorites menu



Organize Favorites command

Click Organize Favorites to opens the Organize Favorites dialog box.

More text to come.

Return to Favorites menu



Menu bar

The menu bar contains the menu titles.



Video area

Video content, branding information, and advertisements are displayed in the Video area. When the size of a video stream or 
media file is larger than the Video area, the player automatically resizes to fit the video inside the player window.



Watermark



Ad banner



Seek bar

You can use the Seek bar to seek through media.



Go To bar

The Go To bar is available only if the content currently being viewed has markers in its index.



Status line

The status line displays information about the status of the player. If you are playing content streamed from the Internet or an 
intranet, a status icon will also be displayed.



Show info

The Show info bar displays information about the playlist currently open, if any. This information is provided by the content 
creator or NetShow administrator.



Clip info

The Clip info bar displays information about the currently playing clip. This information is provided by the content creator. If no 
information is provided by the author, a default icon is used in the Clip information panel.



Title bar

The title bar shows the title of the current file. If you are viewing a clip or show opened through a link in a Web page, the title bar 
will reflect the title of the file defined in the link.



Connection Status
Text to come.



Menu bar

The menu bar contains the menus.



Maximize button

Click the Maximize button to make the player window as large as possible with your current screen resolution settings.



Minimize button

Click the Minimize button to minimize the player window.



Close button

Click the Close button to close (or exit) the player.



Play button

Click the Play button to begin the playback of the open media. By default, a file or stream begins to play automatically when it is 
opened.



Stop button

Click the Stop button to stop the playback of a title. Clicking Stop does not close the file or close your connection to a streaming 
server.



Pause button

Click the Pause button to pause the playback of the content playing.



Skip Back button

Click the Skip Back button to skip to the previous item in a playlist. The Skip buttons are available only if the clip you are 
currently viewing is part of a playlist. Playlists can only be defined using an ASX metafiles.



Skip Forward button

Click the Skip Forward button to skip to the beginning of the next clip in a playlist. This button is available only when the content
you are viewing is part of a playlist opened using an ASX metafile.



Fast Forward button

Click the Fast Forward button to fast-forward through a clip. To fast-forward more than a few frames, click Fast Forward and 
hold down the mouse button.

Clicking the Fast Forward while in Preview mode causes you to exit Preview mode. To return to Preview mode, click the 
Preview button again.



Rewind Button

Click the Rewind button to rewind through a clip. To rewind more than a few frames, click Rewind and hold down the mouse 
button. 

Clicking the Rewind button while in Preview mode causes you to exit Preview mode. To return to Preview mode, click the 
Preview button again.



Separator

This is a separator.



Preview Mode button

Click the Preview button to start or stop Preview mode. The default preview duration is 10 seconds. If the preview of a clip lasts 
longer than 10 seconds, it means the default duration for the preview was altered by the content creator.



Mute icon

Click the Mute icon to mute the audio playback. To turn off muting, click the icon again.

The Mute icon is unavailable if your computer does not have a sound card or sound driver installed.



Volume slider

Use the Volume slider to control the volume level of the content you are viewing.

The Volume slider is unavailable if your computer does not have a sound card or sound driver installed.



Elapsed Time / Total Time indicator

This displays the amount of time the current media has been playing over the total length of the media. Only the Elapsed time is 
displayed when playing real-time streams.



Audio icon

The Audio icon is a dynamic icon. The icon that is displayed depends on the audio content.

Images to come.



Clip icon

The Clip icon displayed is the default icon unless you opened an ASX file to play the media currently playing. In an ASX file, the 
author can insert custom icons that are displayed in the player.



Reserved space



Status icon

The Status icon is dynamic, meaning that the icon displayed changes based on the reception quality of the playback.

Images to come.



Show icon

The icon displayed next to the show title is the default NetShow icon unless the content creator uses an ASX file to define a 
custom icon to be displayed.

More text to come.



codec

Short for compressor / decompressor. A codec is an algorithm or scheme used when recording digital video or audio. A codec is 
used, for example, when video is transmitted over the Internet; the video must be compressed on the sending end and 
decompressed on the receiving end. NetShow provides a choice of codecs for NetShow content. Users can select a codec 
based on the audio or image quality, and image size preferred. 



protocol

A set of formats and procedures for the exchange of information between computers.



packet

A unit of data transmitted over a network. A packet is of fixed size and is routed between a source and a destination. It contains 
binary information that represents both data and a header containing an ID number, source address, destination address, and 
error-control data.



Open button

Click the Open button to open the selected favorite.



Move button

Click the Move button to move the selected favorite to a different folder.



Rename button

Click the Rename button to change the name of the selected favorite.



Delete button

Click the Delete button to delete the selected favorite.



Close button

Click the Close button to close the Organize Favorites dialog box.



Advanced Streaming redirector (ASX or .asx) file

A file quickly loaded by the client that contains information for the following purposes:
To transfer control from the Hypertext Transfer Protocol (HTTP) browser to the player control, so that streams can be 

directed to the player.
To represent an announcement of information necessary to access a program on a NetShow station.
To provide references to multiple pieces of content and rules for protocol rollover that the client uses to process them.
To provide a play list that defines the order in which pieces of content are streamed to the player.

Asx files follow the Extensible Markup Language (XML) standard.



NetShow Theater Server Troubleshooting

The following list includes common error messages.

File not found:    filename.

There was no timely response from server

Could not locate server:    sever.

Invalid name:    filename.

You do not have access to the location or file

Protocol mismatch error.

The specified stream type is not recognized.

A network service failed.

An attempt to acquire a network resource failed.

The server session limit had been exceeded.

The network connection had failed.

Could not connect to server:      server  .  

The operation timed out, possibly due to network problems.

The content can not be played at the selected speed.

The filename failed to play.

The server's maximum bit rate was exceeded.

The client's request is invalid in the current state.

The server is unreliable because multiple components failed.



File not found: filename. Please verify that the path is correct. 

The file name you specified was incorrect. Obtain the correct file name for the title you want to view. 

This is a standard Windows error message. There is no "path" to the NetShow Theater Server title. Verify that the spelling of the 
title is correct and that it is located on the NetShow Theater Server you specified. 



There was no timely response from server.

The requested operation was unable to be completed in a timely fashion.    Try again and contact your administrator if the 
problem persists.



Could not locate server: server. Please see the Help file. 

The server name you specified was incorrect. Obtain the correct name for this server. Do not include any special characters (//, 
$, #, *, and so on) in the title server name.



Invalid name: filename. The file name specified is incorrect. 

You must specify a valid NetShow Theater Server URL. For example, 

nsm://server/spaceneedle.vod 



You do not have access to the location or file. 
You need to have access to the NetShow Theater title server. Check with your NetShow Theater Server administrator to 
determine whether your access to these titles is current. 



Protocol mismatch error. 
Check the version number of your NetShow Theater Server software. The NetShow Theater title server and Media Player client 
must be compatible. 



The specified stream type is not recognized. 

Media Player is unable to render this stream.    This can happen if Media Player was not installed properly or if the required 
codec for this stream was not installed. Reinstall Media Player from the NetShow Theater Server compact disc.

If you can play some NetShow Theater Server titles but not a particular title, report this condition to your system administrator, 
and try again later.



A network service failed. 

NetShow Theater Server requires network services to be functioning properly on the client, on the title server, and on the content
servers. Check the network services on these computers. 



An attempt to acquire a network resource failed.

Media Player could not locate the required network resource within the time allotted for this operation. This resource may be 
busy or offline. Report this condition to your system administrator, and try again later.



The server session limit had been exceeded.

The number of concurrent streaming clients has exceeded the configured maximum streaming clients value set my by the 
administrator.



The network connection had failed.

The connection between the player and video server has failed. Report this condition to your system administrator, and try again 
later.



The content can not be played at the selected speed. The request to fast forward or rewind could not be fulfilled.

Media Player is requesting playback of a title at a playback speed that the video server cannot deliver.    Media Player is 
requesting to fast forward or fast rewind a title that does not support these operations.



Could not connect to server: server. Please see the Help file. 

The server was located on the network, but a connection was not made. Contact the NetShow Theater Server administrator to 
verify the status of the server. 



Operation timed out, possibly due to network problems. 

Check with your network administrator to verify the connectivity between components on your dedicated NetShow Theater 
Server network. 



The filename failed to play.

There is a problem with the title you selected. Although present on the title server, this title did not initialize properly. Ask your 
NetShow TheaterServer administrator to check this title.



The server's maximum bit rate was exceeded. The server’s maximum aggregate bandwidth was exceeded.

The bit rate of the title requested exceeds the maximum bit rate. The NetShow Theater video server is unable to stream this title 
since doing so would exceed the maximum aggregate bandwidth for which the video server was configured.    Report this 
condition to your system administrator, and try again later.



The client's request is invalid in the current state.

The request received from Media Player does not match the current state of the player. Report this condition to your system 
administrator.



The server is unreliable because multiple components failed.

The server is experiencing multiple hardware or network equipment failures.    Report this condition to your system administrator, 
and try again later.



Media Player Glossary

Advanced Streaming Format (ASF)



Advanced Streaming Format (ASF)

A low-overhead data format for multimedia streams, encapsulating images, audio, and Audio Video Interleave (AVI) files, as well 
as Uniform Resource Locators (URLs). Allows for synchronization of these objects within a stream.



authentication

The process of verifying a client’s logon information. A NetShow unicast server can be set to authenticate clients before they are 
given access to NetShow content.



authorization

The process of granting or denying access permissions to clients. A NetShow unicast server can be set to authorize client 
requests for NetShow content.



bandwidth

The amount of data that can be transmitted in a fixed amount of time. On computer networks, higher bandwidth indicates faster 
data transfer. Network bandwidth is expressed in bits per second (bps).

In the NetShow environment, Microsoft NetShow Administrator can specify bandwidth constraints for a variety of functions, 
including maximum aggregate bandwidth unicast from a server, maximum bandwidth for a single unicast stream from a server, 
and the continuous bandwidth used by a multicast file transfer.



bit rate

The speed at which binary content can be streamed across a network. It is usually measured in kilobits per second (Kbps)—for 
example, 28.8 Kbps. NetShow Encoder and NetShow Administrator have settings for the bit rate of ASF content.



broadcast

A connection in which a client receives a multicast or unicast stream. The client chooses to attach to the stream, which enables it
to receive the stream, or to disconnect from the stream. The client, however, does not control when the stream is started or 
stopped. If a client attempts to find a stream by seeking its publishing point or station, and if the stream has not been started, the 
client does not find or receive the stream.



buffer

An area of memory that provides an uninterrupted flow of data between computers.



events (system)

System occurrences, such as user logons, that are logged by a tool designed to monitor such occurrences, and to display them 
in a window, or record them in a file. NetShow Server Trace, which is included with NetShow Administrator, logs NetShow events
to a window. NetShow Server Log saves these events in a database. There also are events sent by NetShow services to the 
Microsoft Windows NT event log, where they can be viewed with the Windows NT Event Viewer.



Extensible Markup Language (XML)

A World Wide Web Consortium (WC3) standard, based on Standard Generalized Markup Language (SGML), for describing data 
on the Web. NetShow uses XML for the structure of .asx files.



firewall

A system or combination of systems that enforces a boundary between two or more networks, and keeps unauthorized users out
of private networks. A firewall system checks all incoming and outgoing messages to make sure they meet predetermined 
security criteria.



frame

One static image of many sequential images that make up a video title.



frame rate

The speed at which individual frames change. High frame rates generally produce better quality images.



home directory

The root directory for publishing ASF content. Microsoft NetShow Player can stream any .asf files placed in this directory or its 
subdirectories. A home directory is also an on-demand publishing point. Unlike other publishing points, a home directory doesn't 
have an alias. Instead, the computer name is used in a NetShow URL for access to the home directory. Also referred to as the 
ASF root directory.



Hypertext Markup Language (HTML)

The language used to format information displayed on corporate intranets and the World Wide Web. HTML is a subset of 
Standard Generalized Markup Language (SGML), and like SGML, HTML uses tags to identify the format for a particular piece of 
information.



Hypertext Transfer Protocol

A protocol used to exchange HTML documents among clients and servers. See also Uniform Resource Locator (URL).



illustrated audio

A stream that combines audio content with synchronized images to make up an online slide show that runs at low bandwidths.



intranet

A network belonging to an organization and accessible only by members of that organization. It can be connected to the Internet,
but usually is protected by a firewall or other device.



IP address

Internet Protocol address. Each computer or device on the Internet has a unique IP address, a 32-bit number that specifies a 
physical location, or node, on the network.



local area network (LAN)

A group of computers and other devices located in a limited area, and connected by a communications link that enables devices 
to interact with other devices on the network.



log

Used to collect and store data about NetShow events. NetShow Administrator can log information about unicasts, multicasts, and
clients.



metadata

In a NetShow system, information, such as URLs, for titles or media content. The information is stored in a metafile.



metafile

In a NetShow system, a text file that contains information, such as a URL, for media content. NetShow uses three kinds of 
metafiles: Advanced Streaming description (ASD) metafiles, Advanced Streaming redirector (ASX) metafiles, and NetShow 
station (NSC) metafiles.



Microsoft Internet Explorer

A Windows-based Web browser produced by Microsoft Corporation. It is used by NetShow in several ways. For example, 
NetShow Administrator uses Internet Explorer to display its Web pages. Content creators can embed the NetShow Player 
ActiveX control in an HTML page that is viewed with Internet Explorer.



MMS protocol

Microsoft Media Server protocol. A protocol used to reference and stream .asf files from a NetShow server. For example: 
mms://server_name/file_name.asf



multicast

A one-to-many connection in which multiple clients can receive the same stream from a server. To receive a multicast, a client 
must have access to a multicast-enabled network. In contrast, a unicast is a one-to-one connection in which one client receives a
distinct stream from a server.



NetShow station file

A file (.nsc) that describes a station to the player. The player opens the station file indirectly or by way of an .asx file that directs 
the client to a specific .nsc file.



.ocx

Frequently used as a synonym for an ActiveX control, .ocx is the file-name extension for a control.



On-demand

Describes stored media content that is available for streaming on a NetShow system. NetShow can stream either stored content 
from a publishing point, or live content using NetShow Encoder.



port

A location on a server from which a client can receive content. A port is represented by a number that is part of a URL. 



PowerPoint Presenter

A NetShow feature, available from within Microsoft PowerPoint. It provides the capability to connect to NetShow Encoder and to 
send a PowerPoint presentation to a NetShow server for distribution to NetShow clients.



program

One or more streams that NetShow manages as a single entity.



property

A characteristic of an object, such as a NetShow stream. For example, NetShow Encoder displays stream properties, such as 
bandwidth and codec, on a properties page.



protocol

A set of formats and procedures for the exchange of information between computers. Protocols used by NetShow include HTTP, 
MMS, and MSBD.



proxy server

A server that mediates interactions between a client, such as Media Player, and a server, such as NetShow Server.



publishing point

A virtual directory for storing content that is available to clients, or for access to a live stream. Clients reach a publishing point 
through its URL.



rollover

The ability of a player to try different protocols automatically to access a stream from a NetShow server. The rules for rolling over
from one protocol to another are defined by a combination of the station definition, the announcement, and various preferences 
set by the user on the client computer.



router

A device that connects two or more networks, and carries data forward. A router determines where the destination computer is 
located, and then finds the best way to transmit the data there.



scalable video content

ASF content that a NetShow server can send at a bit rate that best matches the bandwidth available to a client. If the content 
creator selects a scalable format for the encoder, the content sent to the server can be distributed in highest quality to clients that
have adequate bandwidth, or in acceptable quality to clients with low bandwidth.



security

Access to a NetShow server. NetShow uses Windows NT security features to limit who can administer a server. NetShow 
administrators must belong to the Administrators group or to the NetShow Administrators group on the computer running 
NetShow Server.



station

A defined location from which a player can receive streams. In effect, it is an IP address and a port. NetShow uses stations with 
ASF streams only, and saves station information as a file with an .nsc extension. (Earlier versions of NetShow referred to a 
station as a channel.)



stream

Data transmitted across a network and any properties associated with the data. Also, data that is streamed is transmitted so that 
it is accessible without delay. Streaming video allows the player to render an almost immediate response instead of waiting for 
an entire file to be downloaded before starting to render.



Transmission Control Protocol/Internet Protocol (TCP/IP)

The collection of networking protocols that allows computers to communicate across networks and the Internet. Every computer 
on the Internet supports TCP/IP.



unicast

A client/server connection in which a client receives an on-demand stream of stored content from a server, or receives a 
broadcast of live content. No other client has access to this stream. In contrast, a multicast is available to multiple clients.



Uniform Resource Locator (URL)

A pointer to information on the Internet. A URL provides the address of a Web page, and consists of:
A protocol identifier, such as http:, mms:, or msbd.
A host name, such as msn.com.
A directory and/or file name, such as contentdir/filename.



user datagram protocol (UDP)

A connectionless transport protocol in the TCP/IP protocol stack. UDP does not provide guaranteed delivery.



video capture card

An add-on board for providing digitized images on a computer. With a video capture card, you can provide live camera or VCR 
input to NetShow Encoder.



Media Player Accessibility Topics

Text to come.








